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What's On This CD?

Welcome to the Graphic Artist Tools CDROM 2.1 and to the world of PlayStation game
development. With this version of the CD , you'll find awealth of files that include software tools,
3rd party plug-ins, tutorials, and sample code for creating award winning -- and lucrative -- games.
ThisHTML page is designed to be run from the CD, so please make sure the Graphic Artist CDROM
isinthedrive.

Warning: The Graphic Artist CD is only meant to be used to help you install the software, but it is
not the primary source for documentation. Use the Technical Reference CD for all of your
documentation needs. The small amount of documentation that exists on the Graphic Artist CD is
duplicated and is searchable on the Technical Reference CD.

Within this CD you'll find the following:

o Software for PlayStation game development. It'sal here -- graphics tools and
file formatting converters, and many Windows based programs that are not included
on the Programmer Tools CD, aswell as tutorias, sprite software, and animation
software. For an index to all of the software on this CD, read \doc\content.pdf. To
read more about the types of software on this CD (and where to find them), read the
document \doc\cat.pdf.

o 3rd Party Software If you are working with 3rd Party software, you'll find information and
relevant filesfor

¢ PhotoShop from Adobe,

¢ Power Animator from Alias-Wavefront ,
¢ 3D Studio from Kinetix,

o LightWave from Newtek, and
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¢ Silicon Graphics.

Warning: Read this document from the CD: This document is designed to be read directly from
the Programmer Tools CD, since some of the hyperlinks are hardcoded with directory paths that may
differ from your computer's environment. So please point your browser to this document on the CD,
not to a copy on your hard-drive. You can also read PDF versions of thisfile on this CD and on the
Technical Reference CD.

Warning: Please Install Adobe Acrobat Some of the hyper-text linksin our HTML
ﬁljl documents point to Adobe Acrobat ".pdf" files. Therefore, you should have an Adobe
k| Acrobat reader available on your system. If not, please follow the instructions
— | \doc\hadobe.pdf. For other information read the document \acrobat\16bit\readme.txt or
\acrobat\32bit\readme.txt.

Warning: These HTML documents are best viewed with HTML 3.0 compatible viewers (or later
versions) that can process tables. Y ou can download the latest and greatest browsers from Netscape
(look for the Netscape Navigator) and Microsoft (look for the Internet Explorer). (Free browsers are
available all over the 'Net, but for legal reasons, we cannot bundle them with this CD. )

Internet Explorer 3.0 and Hyperlink problems with CD

Internet Explorer 3.02 suffers from a bug that preventsit from being able to parse some of the
hyperlinks in this document correctly. Internet Explorer 4.0 has fixed this bug, so you may want to
download it from http://www.microsoft.com.

Internet Explorer and PDF file problems

Some versions of Microsoft's Internet Explorer (prior to version 3.02) may have difficulty in showing
the ".pdf" files. To see the PDF's, make sure you install Adobe Acrobat and do the following with
Adobe Acrobat:

1. Choose File > Open, then click Browse.

2. Choose All Files from the Files Of Type pop-up menu.

3. Choose the Programmer Tools CD's drive letter, then select the document that is indicated by
the hyperlinked name.

4. Click Open. Now you should be able to read the PDF file.

If you still have problems, problems could include a damaged PDF viewer or afull browser cache. In
any event, read the document \acrobat\16bit\readme.txt or \acrobat\32bit\readme.txt or just contact
Technical Support.

Netscape Navigator and PDF file problems.

If you click on a PDF file link, and Adobe Acrobat doesn't launch, you may need to re-configure your
system to use Acrobat. The following instructions are for Netscape Navigator 3.0, but they may apply
to later versions of Navigator. First check to see what Plug-Ins are already available:

1. Choose "Help > About Plug-Ins’.

2. Search for Adobe Acrobat. If it doesn't exist, you'll need to install it using the steps given
below. If it does exist, make sure thefile listed as the "File Name" itself exists.
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3. If it doesn't exist, click on the menu item "Options > General Preferences’.

4. Select the "Helpers' tab.

5. Select "Create New Type...".

6. For "Mime Type", type "Adobe/pdf". For "Sub Type", type "PDF". For "File Extensions', type
"PDF".

7. For the"Action" field, choose the "Action” field and click on the "Browse" button. Click down

the directory structure to the appropriate Acrobat Reader which you installed -- for example, a
default installation may have placed the reader in "c:\Acroread\Acroread.exe".
8. Click on"OK".

Again, if you still have problems, problems could include a damaged PDF viewer or afull browser
cache. In any event, read the document \acrobat\16bit\readme.txt or \acrobat\32bit\readme.txt or just

contact Technical Support.

How do I install the software? 5%

If you have Windows 95, you can simply run "setup.exe" in the root directory of the CD. Just click on
itsicon within the Windows 95 explorer. Alternatively, you can install the files manually by
following the installation instructions in \doc\install.pdf .

Technical Support, Web Sites, and Addresses

If you're having problems, we highly recommend that you first search the Technical

Reference CD -- it's the same tool we use at Technical Support when we attack a

problem. Chances are that somebody has had your problem before, and it's been solved

and documented on the Technical Reference CD. But don't bang your head against the

wall! If (and only if) you are a licensed devel oper, you can reach technical support for :
your region at the following addresses and tel ephone numbers. For more information and §
for a set of bug report forms, refer to the Technical Reference CD. :

SN Systems. These chaps write the compilers for the standard PlayStation development kits, as well
as develop the CD-Emulator and their own Windows debuggers for all of the development boards.
All licensees of SCEA and SCEE are welcome to email bug reports or ask questions about the
compilers. They are super friendly, and as many developer will attest, super helpful.

E-mail: support@snsys.com .

Web Site: http://www.snsys.com.

Sony Computer Entertainment America Inc. SCEA is available to licensees who have signed an
agreement with Sony Computer Entertainment America Inc.

E-mail: DevTech Support@playstation.sony.com

Web Site: http://www.scea.sony.com/dev

Developer Support Hotline: 650-655-8181, Monday through Friday, 8am to 5pm, Pacific Standard
Time.

Mail: Sony Computer Entertainment AmericaInc., 919 East Hillsdale Blvd., 2nd Floor, Foster City
CA 94404
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Sony Computer Entertainment Europe. SCEE is available to those licensees who have signed an
agreement with Sony Computer Entertainment Europe.

E-mail: dev_support@interactive.sony.com

Web Site: https.//www-s.playstation.co.uk

Developer Support Hotline:+44 (0) 171 390 1680

Mail: Waverley House 7-12 Noel Street London W1V 4HH

The Technical Reference CD. The companion CD, the Technical Reference CD included in your
software kit, is an indispensible tool which you will use over and over again. It is the definitive
resource for programmers. It contains every document, technical note, and manual written for this
release of the PlayStation software and hardware, in pre-indexed Adobe Acrobat format, including
dumps of the BBS's from SCE in Japan, SCEA in America, and SCEE in Europe, as well asthis
HTML document. With its powerful search engine, you can quickly locate the information you need.
The Adobe Acrobat Reader is already included on the Technical Reference CD. Just click on the
installation icon to set it up on your Macintosh or PC. For more information, read \doc\hadobe.pdf.

We appreciate your comments and suggestions about our HTML
SONY documentation project. Contact us at
DevTech Support@interactive.sony.com

<
{ > Copyright © 1997 Sony Computer Entertainment Americalnc. All Rights

Reserved.
PlayStation and PlayStation logos are trademarks of Sony Computer
COMPUTER Entertainment Inc. All other trademarks are property of their respective

owners and/or their licensors.
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Installing and Using Adobe Acrobat

Why do | need Adobe Acrobat for PlayStation programming?

Because al of the documentation isin the".pdf" format on the Technical Reference CDROM and
all of the documents have been pre-indexed to allow for rapid searching on keywords. The Technical
Reference CD-ROM isyour primary documentation source. The Programmer Tools CD-ROM and
the Graphic Artist CD-ROM are primarily used only for installation of your software. All
documentation that exists on the Programmer Tools CD-ROM and the Graphic Artist CD-ROM,
including HTML documentation, is duplicated and is searchable on the Technical Reference
CD-ROM.

Where can | get a copy?
All Adobe acrobat files for both Windows 3.1 and Windows 95 are in the directory \acrobat.

Toinstall Acrobat, run the "setup.exe" program in the directory \acrobat\16bit\install (for Windows
3.1 users) or \acrobat\32bit\install (for Windows 95 users).

Alternatively, you can hunt around on the Web for the latest version at http://www.adobe.com.

How do | use the Adobe Acrobat reader to perform searches in
multiple documents?

1. Make sure Adobe Acrobat isinstalled on your system.
2. Read the document \acrobat\16bit\hel p\search. pdf

Now you can use these two buttons:

Slep 1.Chck here to enter the text you're looking for

[=]

= [ [HE] [y |@ e w14 « [ ][] ] B || [ #

Step 2 Click here to see the list of search results._.
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We appreciate your comments and suggestions about our HTML
SONY documentation project. Contact us at

DevTech Support@interactive.sony.com

<
{ | Copyright © 1997 Sony Computer Entertainment America lnc. All Rights
) d

Reserved.
PlayStation and PlayStation logos are trademarks of Sony Computer
COMPUTER Entertainment Inc. All other trademarks are property of their respective

owners and/or their licensors.
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Windows 95 Installation

Double-click on the "setup95.exe" program in the root directory of the CD-ROM. Then follow the
on-screen instructions to install the tools you need.

Windows 3.1 Installation

Using the File Manager, copy the contents of the \psxgraph directory to your hard-drive, preferably in
something like c:\ps\psxgraph. Alternatively, you can open an MS-DOS prompt and type the
following command:

xcopy /s d:\psxgraph c:\ps\psxgraph.

Some of the Windows-based programs can only be executed by clicking on their icons. Windows 3.1
does not automatically associate them with their icons; you must do this manually. Refer to the table
and instructions below to associate the programs with their icons.

Application [Description Field[Suggested Command Line Field
Aboard.exe  |Aboard Utility  |c:\ps\psxgraph\bin\aboard.exe
Animatio.exe JAnimation Tool |c:\ps\psxgraph\bin\animatio.exe
Dxf2rsdw.exe IDXF2RSDW c:\ps\psxgraph\bin\dxf2rsdw.exe
meditor.exe |Materials Editor |c:\ps\psxgraph\bin\meditor.exe
mimewave.exgM | Mewave Editor|c:\ps\psxgraph\bin\mimewave.exe
Sprite.exe Sprite Editor c:\ps\psxgraph\bin\sprite.exe

timutil.exe  [TIM Utility c:\ps\psxgraph\bin\timutil.exe
movconv.exe |Movie Converter [c:\ps\psxgraph\bin\movconv.exe
movpack.exe [Movie Pack c:\ps\psxgraph\bin\movpack.exe

For each Application in the table above, do the following:

Select the name of the Application you want to install, such as "aboard.exe".

In the Windows 3.1 Program Manager, select the menu item "File:New" button.

Select Program Item; press OK

A Program Item Properties dialog will pop up. Fill in the "Description field" with the contents

of the Description Field above, such as"Aboard Utility".

5. Usethe Browse, to identify the name of the executable to be placed in the "Command Line"
field, such as"c:\ps\psxgraph\bin\aboard.exe" in the table above.

6. Click Ok.

APWDNPE

For more information on associating programs with icons, consult a good Windows manual. And if
you actually are programming under Windows 3.1, please send us email at

DevTech Support@interactive.sony.com. We need to know if there are any Windows 3.1 developers
out there!
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We appreciate your comments and suggestions about our HTML
SONY documentation project. Contact us at

DevTech Support@interactive.sony.com

<
{ | Copyright © 1997 Sony Computer Entertainment America lnc. All Rights
) d

Reserved.
PlayStation and PlayStation logos are trademarks of Sony Computer
COMPUTER Entertainment Inc. All other trademarks are property of their respective

owners and/or their licensors.

file\\Scea919pl4501a\home\CWang\GRAPHART\HTML\inst31.htm 12/4/97



\\Scea919pl4501a\group sharel\DevSupp\interna... Pagelof 1

[ Welcome | What's New? | Installation | Technical Support |
[ Overview of Toolson CD | Index of Toolson CD | Samples]

C rar.lnf 23 3mﬁ* i ;

There haven't been many changes to the Graphic Artist Tools since the previous CD Release, other
than the following:

« INEW Adobe Photoshop 4.0 plug-ins are now available.
« NEW A betaversion of plug-in for Alias-Wavefront version 8.0 is now available.
« NEW Check the \beta\readme.txt for new tools now in beta production, including new sound
tools.
+ Read the Overview and the Index. Look for the " NEW " |abel in the following :
* Read \doc\cat.pdf for an overview of all of the files on the CD (this was formerly
known as the "CATagories' document).
* Read \doc\content.pdf for an index of all the tools sorted by name.
In addition, tools that were updated (relative to the previous CD release) are marked by the ™

UPDATED" | ahel. Obsolete tools are marked by the "PELETED" | gy

We appreciate your comments and suggestions about our HTML
SONY documentation project. Contact us at
DevTech Support@interactive.sony.com

‘ < Copyright © 1997 Sony Computer Entertainment Americalnc. All Rights
»

Reserved.

PlayStation and PlayStation logos are trademarks of Sony Computer
COMPUTER Entertainment Inc. All other trademarks are property of their respective
o owners and/or their licensors.
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Contents Overview

| ABrief Deschpfoni

=CjOr=3

There are so many files that it can become confusing to determine what is exactly on this CD, and it's
very difficult for usto know how to present the information to you. Therefore, we're trying to
provide you with several ways of finding the files.

This document describes all of the categories of software provided by SCE, its subsidiaries, and its
tool partners. For ease of maintenance, thisfileis on both the Programmer Tools CD and Graphic
Artist Tools CD, therefore some hyperlinks will not work if the wrong CD is placed in the CD-ROM
drive:

« Sectionsthat are relevant only to the Programmer Tools CD are indicated as Available only
on the Programmer Tools CD.

» Sectionsthat are relevant only to the Graphic Artist Tools CD are indicated as Available only
on the Graphic Artist Tools CD.

* Theremaining files can be found on both CD's.

Thislist should be read in conjunction with the "Family Type" column of the Tool Index in
\doc\content.pdf.

2D Artist Tools

Directory: \psxgraph\bin

2D artist tools are intended to help you work with sprites or any 2D bitmap. Generally, these tools
are used to convert to the PlayStation's TIM format, and to position the image and its clut on the
PlayStation's VRAM.

On the Programmer Tools CD, these tools are expected to be run in an MS-DOS window.

The Graphic Artist Tools CD contains the MS-DOS based tools plus Windows based converters, as
well as Adobe PhotoShop plug-ins.
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For more information, refer to the Overview Manual and the 3D Artist Tools manual on the
Technical Reference CDROM. If you are a programmer, you should study the graphics samplesin
"\psx\sampl e\graphicsituto” and "\psx\sample\graphics\2D". Many of the TIM images are stored in
header files as arrays of type "unsigned long";

timtool.exe isauseful tool that allows the placement of Playstation TIM files within the Playstation
Frame Buffer, and supports conversion of the following formats. Windows BMP, JPEG, TIFF, PCX,
and PNG. Contributed by Malachy Duffin and Mark Breugelmans, SCEE. Refer to the
document \psxgraph\bin\timtool.txt for release information. A Windows .HLP file is included which
describes some of the other features of the tool.

3D Artist Tools

Directory: \psxgraph\bin

3D Artist Tools help you work with 3D dimensional data, such as the DXF format, and the text-file
based PlayStation RSD format. Convertersin this category can then create a PlayStation TMD
formatted file, which can be read by routinesin libgs.

3D Studio Plug-ins

Directory: \3rdParty\3DS

These tools, written at SCE (Japan), are used with 3D Studio. They are provided in the directory
\psxgraph\bin for backwards compatibility, but we have also placed them in a separate directory in
\3rdParty\3DS. Full information and instructions can be found in the directory "\psx\3rdParty\3DS"
on the Programmer Tools CD and the Graphic Artist Tools CD:

* For installation instructions, read \3rdParty\3DS\3D Stod.txt.
* For release note information, read \3rdParty\3Ds\rel ease.txt

Warning: Remove the SN-Dongle, and attach the 3D Studio dongle before progressing with a
modeling session that uses the 3D Studio plug-in. Do not remove or add dongles whilethe PC is
powered ON.

Warning: Always remove dexbios, cdbios, and messl (if they are already installed) before starting a
3D Studio plug in session.

Adobe PhotoShop Plug-Ins

Available only on the Graphic Artist Tools CD
Directory: \3rdParty\Adobe

Adobe PhotoShop plug-ins allow you to use the power of PhotoShop to create TIM files. The plug-in
can import and export TIM format files, and preview the image directly on the television screen
through the Graphic Artist Board (DTL-H201A). There are plug-ins for the following versions of
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PhotoShop:

e PhotoShop 2.5
e PhotoShop 3.0

« PhotoShop 4.0. NEW

For more information, refer to the document \psx\3rdParty\A dobe\readme.txt.

Alias-Wavefront Plug-Ins

Directory: \3rdParty\AliasWav

The Alias-Wavefront 8.0 plug-in is stored as \3rdParty\alias\alias8 O\AliasTar.gz. Thisfile was
created on a PC using WinZip and contains a compressed tar archive file. Y ou should download this
from a PC, unzip it with WinZip, then transfer it to your Unix workstation. From there, run
"uncompress dlias.tar”, then "tar xvf aias.tar".

Then you need to install it.

e For quick installation instructions, read the directionsin
\3rdParty\AliasWav\Alias8 O\install.txt.

* Alias8.0 and later are not supported on Irix 5.3; running Alias 8.0 and the PlayStation
trandator on an Irix 5.3 machine may cause a Fatal Error in Alias. This has been fixed in Alias
8.1, but you may want to read this for more information.

* A full users manual can be found here.

NEW A beta plugin for Alias 8.2 existsin the directory \3rdParty\AliasWav\Beta. Transfer thisfile
to your SGI machine, rename it with mv alias82.tgz alias82.9z , use gzip -d alias82.tgz to
decompressiit, then run tar -xvf alias82.tar to unpack it.

Artist Board and the Materials Editor

Available only on the Graphic Artist Tools CD
Directory: \psxgraph\bin

The Material Editor isatool that edits surface attributes (materials) of polygons, such as colors,
textures (patterns), and method of shading of 3D models.

In order to use the Materials Editor, set the I/O address to access the artist board (DTL-H201A) using
the Windows tool, "aboard.exe".

Refer to the Developer Reference Series, 3D Graphics Tool User's Manual on the Technical
Reference CD, for additional information on "aboard.exe".

Bug note for Aboard.exe: The address settings list in this program does not allow you to set the
address to be 0x1360 even though the board may be set to that.
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Batch Files

Directory: \psx\bin

These example batch files usually consist of a one or two line command, and are written merely to
help ease the pain of typing long path names. For example, rather than typing

run c:\ps\pssn\bin\sel cd

(which allows the devel opment boards to access their own CD-ROM drives), you could place the
same command in abatch file called "runselcd.bat".

These files are not machine generated, and the correct paths will vary depending on your
development system setup. Therefore, please use them only as examples.

Beta Software

Directory: \beta

Thisdirectory contains a number of software development tools (and sometimes library files) that are
considered to be in beta. Read \beta\readme.txt for more information.

Brief Editor

Directory: \psx\bin

These files are useful for the Brief Editor, the "Programmer's Editor”, according to some. They
consist of the macro source and a compiled version of the macros.

For more information, refer to the "SDevTC Development Environment” manual on the Technical
Reference CD.

CD Generation Tools

Available only on the Programmer Tools CD
Directory: \CdGen

"CDGEN.exe" isan application that allows you to create PlayStation gold disks. However, CDGEN
is sold separately.

In the Programmer Tools CD, we've provided the licensing files, which are required when you make
a PlayStation CD that you can play on your blue debugging stations. The licensing files are in the
directory \CdGen\LcnsFile.

Y ou can use the utility MCheck to verify your mastering information. The Windows 3.1 and
Windows 95 versions of MCheck are in the directory \CdGen\M Check and \CdGen\M Check95.

Here's aquick summary of the steps you need to do to make a debug station CD:
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1. Renpve PCRead( ), pollhost( ), and other PC file systemcalls from your code.
2. Link with 2nbyte.obj. For library versions 3.1 and later, the

2nmbyt e. obj and 8nbyte.obj are no | onger required.

Wth versions 3.1 and | ater, the heap sector for SP initial

val ues or at the start up can be set by defining the two vari abl es

of _ramsize and _stacksize in the program If you are defining two

vari abl es, please nake sure that both are defined.

If only one of the two is being defined, an error occurs at

the tine of establishing a |ink.

int ransize = 0x00200000; /* RAM Sl ZE */
int _stacksize = 0x00008000; /* STACK SIZE */

3. Execute cpe2x.exe /C[area] on the .cpe file.
4. Add files to CDGEN. Choose the correct file type for XA itens.

- Use Mbde 2 Form 1 for game data.

- Use Mbde 2 Form2 for XA files.

- Select both Form1l and Form 2 for a conbi ned audi o and video file
- Use the file type button to set the type for each file.

- Standard file is Mdde 2 Form 1.

5. Using the additional dialog button in the volune panel of CDGEN, set the System
File to the path of your conpany's licenseX dat file. For exanple
c:\cdgen\licenseA. dat

6. Using the master dialog button in the |ayout panel of CDGEN, set the
Li cense Area to :
- J is you have a Japanese debug station.
- Aif you have an Anerican debug station.
- Eif you have a European debug station.

7. Set the minutes to 74 m nutes. However, you should use 71 mnue nedia. A
74 mnutes nmedia mght work, but we do not support it. You nust use the
CD-R71PS for the nmastering process for submi ssions to SONY.

8. In CDGEN, press the record (REC) button.

9. Always verify the conpl eted disk.

For more information, please consult the Technical Reference CD.

Compilers

Available only on the Programmer Tools CD
Directories: \gnu, \pssn\bin, and \pssn\windebug

The SDevTC development environment consists of SN System's rapid assembler and the Gnu
compiler. These tools are MS-DOS commands and should be run in an MS-DOS console window.

The assembler and linker components are in \pssn\bin, and the compiler components are in the \gnu
directory of the Programmer Tools CDROM. Two versions exist:

* 16-bit compiler. The GNU portions exist on the Programmer Tools CD in the directory
\gnu\dos, and the assembler and linkers appear in \pssn\bin\dos. Follow the instructions in the
section "INSTALLATION FOR WINDOWS 3.1" in the document \README.TXT at the root
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of this CD-ROM. In your makefiles, change the usual references of "ccpsx” to "ccpsxd”,
"psylink” to "psylinkd", and "psylib" to "psylibd". Set your paths as discussed in the document
"\doc\instsoft.pdf".

e 32-bit compiler. The GNU portions exist on the Programmer Tools CD in the directory \gnu,
and the assember and linkers appear in \pssn\bin. These are the default versions that are
installed using the "setup.exe” utility of the Programmer Tools CD. Naturally, they only
operate under 32-bit operating systems.

Note: The important file "sn.ini" (formerly known as "psyq.ini") resides in \pssn\bin, and allows you
to specify which libraries need to be linked into your program. With each CD-ROM release, this file
will change to accomodate new libraries.

Toinstall these tools, you can simply run "setup.exe" on the Programmer Tools CD in Windows 95,
and choose the "SDevTC Tools" and the "C-Compiler" options.

If you don't have Windows 95, or if you need more information, refer to the following:

e Theinstallation manualsin \psx\bin\DTLH2000 or \psx\bin\DTL H2500.
« Psy-Q Development Environment, on the Technical Reference CD-ROM.

In addition, a new Windows 95 debugger for the DTL-H2000 system from SN isincluded on this
CD, in the directory \pssn\windebug.

HMD

Directory: \psxgraph\bin

The Hierarchical Mesh Definition file format allows LIBGS based programs to manipul ate complex
hierarchical models with animation. Refer to the directory (on the Programmer Tools CD only)
\psx\sample\hmd for samples that demonstrate how to process the objects. In addition, in the
\psx\sample\nmd\data directory are a number of models, each with a"readme.txt" that describes how
they were made.

NewTek's LightWave

Directory: \3rdParty\LightWav

Support for LightWave can be found in the directory \3rdParty\LightWav. Read the document
\3rdParty\LightWav\readme.txt" for more information.

Metrowerks Files

Available only on the Programmer Tools CD
Directory: \3rdParty\Metrower

Within this directory are a number of subdirectories that contain PlayStation libraries and
executabl es associated with the Metroworks CodeWarrior for PlayStation. The directories are as
follows:

file\\Scea919pl4501a\group sharel\DevSupp\interna\Alpha2. 1\GRAPHART\HTML\cat.htm  12/8/97



\\Scea919pl4501a\group sharel\DevSupp\interna... Page 7 of 12

« NEW /ib. This archive contains CodeWarrior formatted files from Library 3.5 to Library 4.1.
In directory is asubdirectory caled "patches’, which contains the library and header filesfor
revisionsto that library. For more information, refer to \3rdParty\M etrower\L ib\readme.txt.

e DECI. Containsinstallation information in its subdirectories for patching the DTL-H2000
CodeWarrior and the firmware for the DTL-H2500. For installation instructions on the
DTL-H2500 firmware upgrade, refer to 3rdParty/M etrower/deci/flash25/readme.txt.

Mime Tools

Available only on the Graphic Artist Tools CD
Directory: \psxgraph\src\preview

MIMe is an animation technique unique to the PlayStation, and can be configured to be aform of
polygona morphing. For an in depth discussion on generating MIMefiles, refer to the 3D Graphics
Tools manual in the Technical Reference CD.

In addition, there is source code for amime-wave previewer, in \psxgraph\src\preview\.

Movie Tools

Directory: \psxgraph\bin

These movietools are a collection of programs used in handling streaming on the PlayStation. The
movie tools contain tools to convert between other movie formats and the PlayStation streaming
format, and tools to pack created streaming data.

MovConv handles the formats shown in the list below for input and output.

e Input format:

e avi (Uncompressed)

* tim series (name-ordered tim files)
* rgb series (name-ordered rgb files)
* yuv series (name-ordered yuv files)
s wav

e Output format:

+ str (MDEC)

e str (24Bit Direct)

* bsseries (name-orderd bsfiles)

e avi (Uncompressed)

* rgb series (name-orderd rgb files)
* Xa

MovPack isatool which interleaves streaming data or XA-ADPCM sound data created by
MovConv, and assigns channel numbersto this data.
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For more information, consult the "Overview Manual" on the Technical Reference CD-ROM, and
the Windows based help files "movpack.hlp" and "movconv.hlp".

Note that these tools have been updated to

« UPDATEDMovConv 2.2E

o UPDATED M ovPack 1.6E.
« NEW MC32.exe 3.0 (beta), found in the directory \betaAM C32.

Obsolete Files

Thesefiles existed in previous versions of the CD-ROM and are no longer required. They have been
deleted, or are scheduled to be deleted, in subsequent releases. They are marked obsolete, or deleted,
within the tables such as the one in the document doc\content.pdf.

Performance Analyzer (DTL-H2700)new

Available only on the Programmer Tools CD
Directory: \PA

For thefirst time, Performance Analyzer files are being distributed on the Programmer Tools CD.
These files include the "PA32.exe" program, flash utilities for the DTL-H2700, and instructions on
installing the DTL-H2700. For more information, read \PA\readme.txt. After using these flash
utilities, you can use the SDevTC toolsin order to compile and debug your program.

SCE Tools

Available only on the Programmer Tools CD
Directory: \psx\bin

These are MS-DOS tools provided by SCE (Japan). For more information, refer to the Technical
Reference CD.

SCE Tools: DTL-H2000

Available only on the Programmer Tools CD
Directory: \psx\bin"\DTLH2000

These files were created by SCE (Japan) for running programs on the DTL-H2000 ISA card. For
information on using them, refer to the directory \psx\bin\DTL H2000.

SCE Tools: DTL-H2500

Available only on the Programmer Tools CD
Directory: \psx\bin"\DTLH2500
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These files were created by SCE (Japan) for running programs on the DTL-H2500 PCI card. For
information on using them, refer to the document \psx\bin\DTL H2500. They are incompatible with
the software driver h25bios.com in the SDevTC development environment, but are needed for
diagnostic purposes and run with the h25drv.exe driver.

SDevTC Tools

Available only on the Programmer Tools CD
Directory: \pssn\bin

These files were created for the SDevTC devel opment environment, and can work with the
DTL-H2000 ISA card, the DTL-H2500 PCI card, and the DTL-H2700 I SA card (the Performance
Analyzer). Such files include the debugger (dbugpsx), utilities to dump the contents of variousfiles
(dumpcpe.exe, dumpexe.exe, dumpobj.exe, and dumpsym.exe), and a "printf" message handler
(mess1.com).

Some brief release notes for these utilities can be found in \pssn\version.txt.

For more information on using the tools, refer to the document " Psy-Q Devel opment Environment
in the Technical Reference CD. Y ou can also refer to either of the directories \psx\bin\DTL H2000 or
\psx\biN\DTL H2500, which have the installation documents that contain tutorials on how to instal
the boards and use them with SCE Tools and SDevTC Tools.

Source code for the utility symmunge and libsn.lib can be found in the directory \pssn\src.

SDevTC Tools: DTL-H2500

Available only on the Programmer Tools CD
Directory: \pssn\bin\DTLH2500

These files were created for the SDevTC development environment for the DTL-H2500 PCI board in
order to initialize its flash BIOS. For more information, refer to the directory \pssn\bin\DTL H2500.

SDevTC Tools:CD

Available only on the Programmer Tools CD
Directory: \pssn\bin

These files enable you to switch between the CD Emulator or the development system's CD-ROM
drive (the DTL-H2010 or the DTL-H2510). For example, with the h25bios.com (or the dexbios.com)
driver running, resetps your system, then type the following:

* run c:\ps\pssn\bin\selemu.cpe, to run your program from the emulator.
* run c:\ps\pssn\bin\selcd.cpe , to run your program from the CD-ROM.

(These examples assume the files exist in c:\ps\pssn\bin.) Now your program can access the fileson
the CD. To boot from the CD, just type run c:\ps\pssn\bin\cdexec.cpe.
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For more information, refer to the instruction manual that comes with the CD Emulator system (sold
separately).

SGI Utilities

Directory: \3rdParty\SGI

UPDATED SCE ported a number of 2D and 3D graphic utilities for SGI workstation operating under
IRIX 5.3, including the movie converter, mimefilt, and mktod. They are in the directory
\3rdParty\SGI. These utilities are stored in a compressed-tar format. Follow the instructions
\3rdParty\SGl\readme.txt for instructions on how to install them. Some of the utilities are
unsupported. Note: The Japanese documents that are inside the compressed archives have been
translated and incorporated into the "Data Converters" book in the Technical Reference CD. We
apologize for the confusion this may cause.

Sound Tools
Directory: \psxgraph\bin

These files are DOS versions of similar files existing for the Sound Artist Board development system
on the Apple(R) Macintosh. They alow you to create MIDI music and create PlayStation sequencing
files, and convert from AIFF format into PlayStation's VAG and VAB formats.

NEW Check the \beta directory for new sound tools!

NEW Check the \psx\utility directory for anew sound library!

For more information, refer to the Technical Reference CD.

Sprite Editor

Available only on the Graphic Artist Tools CD
Directory: \psxgraph\bin

The sprite editor is an image data tool dedicated to the PlayStation. It provides the capability to
create data interactively with sprite and BG picture components on Windows. For more information,
read the Sprite Editor manual on the Technical Reference CD.

Note:In order to use the Sprite Editor the user must set their windows display drivers to 256 colors
(an 8-hit palette).

System Files

These files should be placed in your \windows\system directory. The Windows 95 "setup.exe" of the
Programmer Tools CD will place them for you. They are so designated in the tables such as the one
in \doc\content.pdf

file\\Scea919pl4501a\group sharel\DevSupp\interna\Alpha2. 1\GRAPHART\HTML\cat.htm  12/8/97



\\Scea919pl4501a\group sharel\DevSupp\interna... Page 11 of 12

Utilities
Available only on the Programmer Tools CD

Directory: \psx\utility

This directory contains various utilities that are useful for PlayStation development. Refer to the
document \psx\utility\readme.txt. for more information.

Windows Art Tools

Available only on the Graphic Artist Tools CD
Directory: \psxgraph\bin

The Graphic Artist CD provides you with the same art tools found on the Programmer Tools CD --
and more. Windows based GUI utilities allow you to work with your tools much more easily than
with the MS-DOS based commands. They include the following:

« Animatio.exe. The Animation Tool of the 3D Graphic Artist Tools.

« DXF2RSDW.exe. A tool that converts from DXF format files (which can be produced by a
variety of modelers) into the PlayStation RSD format.

* meditor.exe. A tool that, with the Graphic Artist Board, allows you to edit the surface
attributes (materials) of 3D polygon meshes, such as colors, textures (patterns), and the type of
shading.

« mimewave.exe A tool used to create waveform datafor MIMe animation. The tool is specific
for the PlayStation system. The PlayStation development board is only needed for previewing,
but not needed for editing.

» sprite.exeAn image data editing tool dedicated to the PlayStation unit.

» timutil.exe. A tool that allows the placement of Playstation TIM files within the Playstation
Frame Buffer, and supports conversion among the following formats: TIM, Windows BMP,
Macintosh PICT, and general purpose RGB.

* timtool.exe . A tool that allows the placement of Playstation TIM files within the Playstation
Frame Buffer, and supports conversion of the following formats. Windows BMP, JPEG, TIFF,
PCX, and PNG. Contributed by Malachy Duffin and Mark Breugelmans, SCEE. Refer to
the document \psxgraph\bin\timtool.txt for release information. A Windows .HLP fileis
included which describes some of the other features of the tool.

Windows-based GPU libraries

Available only on the Graphic Artist Tools CD
Directory \psxgraph\wingpu

In the directory \psxgraph\wingpu are the statically linked libraries and aDLL that enable you to
write your own Windows applications that can communicate with the Graphic Artist Board, making
it possible to write your own Material Editor! The contents of the sub-directories are as follows:

* Wingpul6. Contains the 16-bit statically linked library and 16-bit DLL. For more information,
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read \psxgraph\develop\wingpul6\readme.txt.
* Wingpu32. Contains the 32-bit statically linked library. For more information, read
\psxgraph\devel op\wingpu32\readme.txt. Note: No 32-bit DLL is available!
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Samples

Sample datathat isused in the Tutoria section of the "3D Graphics Tools" manual (in the Technical
Reference CD) can be found in the directory \psxgraph\tutorial.
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[ Welcome | What's New? | Installation | Technical Support |
[ Overview of Toolson CD | Index of Toolson CD | Samples]
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This CD contains awealth of tools for the PlayStation graphic artist:

_I}f_l;*:,ng l{Jrl

* 16-bit and 32-bit DLLs and statically linked libraries for communicating with the Graphic
Artist Board.

* Toolsfor MIMe animation.

» All sourcefor the tutorial in the 3D Graphics Tools manual, in the directory \psxgraph\tutorial.

* A widevariety of MS-DOS and Windows utilities, listed in the table below.

In addition, this CD contains software and instructions for the following 3rd party hardware and
software:

e Adobe PhotoShop
* AliasWavefront

e 3D Studio

e LightWave4.0

. SGI.

Full information and insructions on the running the tools is available in the Technical Reference
CDROM. Thelisting below is an alphabetized list of all of the tools. Y ou may need to refer to this
table to get version numbers.

File name \Version|Description Family Type |Location
Sets 1/0 address to access Graphic : .
aboard.exe 1.00e Artist Board DTL-H201A ArtistBoard psxgraph\bin
siff2vag.exe gFfATED ﬁt : Il?:;to VAG sound format conversion Sound Tools psxgraph\bin
- NEW |, . . Alias-Wavefront,
Alias 82.tgz Beta Alias-Wavefront 8.2 plug-in Plua-In \3rdParty\Alias\Be
Alias-Wavefront converter from A lias-Wavefront
aliaspsx.8.0.tar.gz8 PlayStation formats (TMD, MIME, and = \3rdParty\Alias\Al
others). Plugin
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animatio.exe 1.1.5 |Animation tool library DLL —¥\(/)|(r)1|dows At psxgraph\bin
between.dl 1.0.3 |Animation tool library DLL —¥\(/)|(r)1|dows At psxgraph\bin

. Converts Windows image data (BMP) .
bmp2tim.exe 22 format to PlayStation TIM format. 2D Art Tool psxgraphibin
Converts DXF file to PlayStation 3D .
dxf2rsd.exe 2.81 Model file format (RSD). 3D Art Tool psxgraph\bin
\Windows application to convert DXF  \Windows Art .
dcf2rsdw.exe 1.10e format file to PlayStation RSD format. [Tool psxgraphibin
dxf2rsdwhip | WindowsHelp filefor dxf2rsd. PIBOUS AT \pexgraphibin
gauge.vbx - Visual Basic file. (Movie Converter) System Files psxgraph\system
NEW |C language preprocessor format .
hmd.def 1.10 _|definition file for HMD SDArtTool — \psxgraphibin
Labp isasimple assembler that is
designed to create HMD data. In this
NEW |versionthe buginthe version 1.00 has .
labp 1.10 [been fixed, and its function has been HMD Taols psxgraphibin
enhanced. For Win 32 MS-DOS
prompts. Used with hmd.def.
lib3d.dil 112 |Animation tool library DLL PIBOUS AT \pexgraphibin
libdata.dll 1.15  |Animation tool library DLL PIBOUS AT \pexgraphibin
Lightwave Light-Wave plug-ins for Alpha, SGI, LightWave . ;
Plug-Ins and Intel platforms. Plug-Ins SrdParty\LightWe
NEW Light-Wave "lws' to enhanced RSD
lworsd.exe Final l;gfrgetltoconverter. For more information, I|5|| uggit}/r\]lsave psxgraphibin
VerSION s dParty/LightWav/L ws2rsd/readme.tt.
NEW . . . . .
mc32.exe Beta 3.OA 32-bit version of "MovConv.exe Movie Tools
. Compressed tar file of movie-converter .
mcnvsgiztar.z | utilities for IRIX 5.3. Unsupported SGI Utilit 3rdParty\SGl\extr
meditor.exe 2.0lae |Materials Editor Tool. ArtistBoard psxgraph\bin
meditor.hlp - \Windows help for Material Editor. ArtistBoard psxgraph\bin
For HMD use. Meshconv scans mesh
structure in specified new-RSD file and
UPDATED creates extended-RSD file (.msh). In
meshconv.exe 11 thisversion, the bugintheversion 1.0 |[HMD Tools psxgraph\bin
' has been fixed, and IRIX version has
been added.\Warning:This application
runs only under Win32.
mimefiltece  [L51 [ odram 0 convert MIME differenceyyivie ity pscgraphibin
mimesort.exe  |2.1 TMD Vertex information sorting tool  [3D Art Tool psxgraph\bin
mimesort.exe 2.1 TMD Vertex information sorting tool ~ IMIME Utility  \psxgraph\bin
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mimewavecpe [Sep.  [MimeWave previewer program IMIME Utility  \psxgraph\bin
mimewave.exe [LOe [MIME Wave Form Editor IMIME Utility  \psxgraph\bin
mimewave.hlp  |Sept \id\!:[\(;jrows help for Mime wave form MIME Utility  [\psxgraph\bin

MkmineisaWin32 MS-DOS prompt
: NEW |command to create HMD data that - .
mkmime.exe 1.10 |contains MIMe. In thisversion the bug MIME Utilit psxgraphibin
in the version 1.00 has been fixed.
mktod.exe 14 Reads project files and creates layout  |3D Studio psxgraph\bin
files. Plug-In
mkvab.exe 2 Utility to build sound source bank Sound Tools psxgraph\bin
Compress movie data into PlayStation
UPDATED movie data format. Compress sound
movconv.exe > datainto CD-ROM XA ADPCM Movie Tools psxgraph\bin
“€ Yormat. Convert movie data among
some movie formats.
\Windows help file for Movie Converter. . .
ELETE .
movconv.hlp D D This has been deleted. Movie Tools psxgraph\bin
movconv..scr UPDATED|Sample script for Movie Converter Movie Tools psxgraph\bin
movoack exe UPDATED I nterleave multiple xa data. Interleave Movie Tools xaraoh\bin
pack. 1.6e |multiple str data. — psxgrep
movpack.hlp DELETED |Windows help file for Movie Pack IMovie Tools psxgraph\bin
movpack.scr UPDATED|Sampl e script for Movie Packer Movie Tools psxgraph\bin
. 3D Studio .
patch.bat - Patch batch file Plug-In psxgraph\bin
i DTL-H2000 patch program (non 3D Studio .
patchw.exe Japanese version) Plug-In psxgraph\bin
NEW PCI_SND is'Windows PC program
pci_snd.exe 10B etawhi ch previews VAB sound files on the |beta beta\pci_snd
' PCI Sound Artist under Windows 95.
o Converts MAC image data (PICT) to a .
pict2tim.exe 3.1 PlayStation image data file (TIM). 2D Art Tool psxgraph\bin
Communication program between 3D Studio
psbload.exe - DTL-H2000 and PC Plug-In 3rdParty\3DS
osboard.ini i DTL-HZOOO port address configuration |3D Studio 3rdParty\aDS
file. Plug-In
i Communication program between 3D Studio
psrtn.exe DTL-H2000 and PC (run program) Plug-In 3rdParty\3DS
.Converts RGB image datato a
rgb2tim.exe 2.1 corresponding PlayStation image data  [2D Art Tool psxgraph\bin
file (TIM).
rsd2dxf.exe 1 Converts RSD file to DXF format 3D Art Tool psxgraph\bin
Converts RSD format filesto HMD
format. Rsd2hmd converts RSD format
UPDATED|into HMD format. In this version, the .
rsdzhmd.exe 1.3 bug in the version 1.1 has been fixed, HMD Toals psxgraphlbin
Warning:This application runs only
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under a Win32 MS-DOS prompt.
rsdcat.exe grggﬁu Links multiple RSD filesinto one 3D Art Tool psxgraph\bin
rsdform.exe 1.81 |Changes and moves 3D modeling data |3D Art Tool psxgraph\bin
. Converts 3D model data (RSD) to 3D .
rsdlink.exe 3.72 mode format (TMD) 3D Art Tool psxgraph\bin
NEW [RSD manuipulation and texture
rsdtool Beta 0.§mapping tool from SCEE. 3D Art Tool betaRSDTool
NEW Rsdup converts the former RSD format
rsdup.exe 10 into the new RSD format that HMD Tools psxgraph\bin
] corresponds to the HMD format.
Seq2sep.exe - Conversion utility for SEQ to SEP Sound Tools psxgraph\bin
. I Port of many of the graphics utilitiesin -
Sgitar.z psxgraph\bin to work on SGI IRIX OS. SGLUIL 3rdParty\SGI
Sky32v3c.dil UPDATED|32-bit DLL for the TIMTOOL (1.x) 2D Art Tool psxgraph\bin
sky32v3c.dll UPDATED|32-bit DLL for the TimTool (1.x) W—WSM psxgraph\bin
smf2seg.exe 2 Conversion utility for SMF to SEQ Sound Tools psxgraph\bin
SNDTOOL isaprogram which
NEW previews VAB sound files on the
sndtool.cpe PlayStation Development Kit. It Beta Software  [\beta\sndtool
1.0 Betq
supports both mouse and PAD
controllers.
Sprite.exe 1.7e  |Windows Sprite Editor tool —¥\(/)|(r)1|dows Art psxgraph\bin
Visual Basic file. (meditor & Movie ,
threed.vbx - Converter) System Files psxgraph\system
tim2bmp.exe 1.1 Converter from TIM to BMP 12D Art Tool psxgraph\bin
timhelp.hip UPDATED|Window help file for TimTool. 2D Art Tool psxgraph\bin
. : . : \Windows Art .
timhelp.hlp UPDATED|Windows help file for TimTool. ool psxgraph\bin
: Changes the VRAM coordinates of a .
impos.exe 11 TIM file'simage dataand CLUT. 2D ArtTool psxgraphibin
Interactive Windows program for
changing the VRAM address of images
timposw.exe 1.1 and color tables (similar to the"TIM 2D Art Tool psxgraph\bin
layout" feature of the "timutil.exe"
application).
timposw.hip - \Windows Help file. 12D Art Tool psxgraph\bin
A tool that allows the placement of
Playstation TIM files within the
i mtool exe UPDATED|Playstation Frame Buffer, and supports |Windows Art xaraoh\bin
' 2.0a [conversion of the following formats: Tool psxgrap
\Windows BMP, JPEG, TIFF, PCX, and
PNG.
A tool that allows the placement of
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PlayStation TIM files within the
: UPDATED|PlayStation Frame Buffer, and supports .
fimtool.exe 2.0a |conversion of the following formats: 2D ArtTool psxgraphibin
\Windows BMP, JPEG, TIFF, PCX, and
PNG.
\Windows utility that converts among
TIM, Windows BMP, Macintosh PICT,
and general-purpose RGB. Allows
timutil.exe 1.36 |placement of TIM fileson PlayStation |2D Art Tool psxgraph\bin
VVRAM. Exports images through the
Graphic Artist Board to atelevision
Screen.

o TIM viewer. Now only released on the .
imview.exe 1.2 Graphic Artist Tools CDROM. 2D Art Tool psxgraphibin
tmd2pmd.exe  |1.14  |Converts TMD fileto a PMD format 2D Art Tool psxgraph\bin
tmd2pmd.exe  |1.14  |Converts TMD fileto a PMD format |2D Art Tool psxgraph\bin
tmdinfo.exe 1.25 ?R/sliljjlazlsecontents of the 3D model data 3D Art Tool psxgraph\bin
tmdsort.exe 1.25 Sorts 3D model datafile (TMD) by 3D Art Tool psxgraph\bin

packet type.
Plug-in program for the Autodesk 3D
Studio (3DS).you can save 3DS object
or animation data in PlayStation format 3D Studio
tod_i.kxp 4.0f (RST,TOD) while using 3DS. You can Plucin 3rdParty\3DS
also preview animation while using 3DS oUgn.
by sending animation data to
Play Station board (DTL-H2000).
todexp.dll 1.0.2 |DLL for TOD export —¥\(/)|(r)1|dowsArt psxgraph\bin
. . 3D Studio .
todv.bat - TOD previewer batch file (no patch) Plug-In psxgraph\bin
todviewb.exe - TOD previewer. —%D Siugio 3rdParty\3DS
ug-In
. , 3D Studio .
todviewb.exe - TOD previewer. Plug-In psxgraph\bin
todvj.bat i TO[_) previewer batch file (Japanese 3D Studio 3rdParty\3DS
\version) Plug-In
todvj.bat i TO[_) previewer batch file (Japanese 3D Studio psxgraph\bin
\version) Plug-In
todvw bat i TO[_) previewer batch file (non Japanese |3D Studio 3rdParty\3DS
\version) Plug-In
todvw bat i TO[_) previewer batch file (non Japanese |3D Studio psxgraph\bin
\version) Plug-In
. Utility to split VAB into an attribute and .
vabsplit.exe 2 \wave data section. Sound Tools psxgraph\bin
NEW [Thisisawindows program to
vabtool exe 1.0 betajcontruct/edit VAB files Beta Software - fbetatvabiool
Thisis awindows program that allows
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vag_Play

NEW
1.0 beta

you to preview programsin a VAB file
on the PC using a standard 16bit PC
sound card.

Beta Software

Page 6 of 6

betal\vabtool

verlltar.Z

Contains a library for accessing the
MDEC encoding routines. A samplefile
isincluded. Unsupported.

SGI Utility

3rdParty\SGl\extr

vh2spu.exe

NEW
1.0 beta

Transforms vabheader (.\VH) fileinto 2
files. an ".SPU" file (contains keyon
datafor libspu ) and an ".OFF"
file(contains waveform data start
address offsets)

Beta Software

beta\vh2spu

Wwav2vag.exe

NEW
1.0 beta

Thisis asimple program which stips off
the header from Windows format '.wav'
files and then shells the Aiff2Vag
program with the correct options. It
requires 16bit mono It runs asaDOS
program with command line parameters..

Beta Software

betal\vabtool

wavlink.exe

June

Converts waveform ".wvf" files output
by MIMEwave into corresponding
binary datafor execution on the
PlayStation.

MIME Utility

psxgraph\bin

xhmd

NEW
1.10

Xhmd isaHMD dis-assembler. In this
\version, the bug in the version 1.00 has
been fixed, and the output format.

specifications have been changed.

HMD Tools

psxgraph\bin

We appreciate your comments and suggestions about our HTML
documentation project. Contact us at
DevTech Support@interactive.sony.com
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